Podcasting in Geography and the Social Sciences

A guide to podcasting with *Audacity*

Justine Kemp†
Jan Oosthoek*
Richard Kotter†
Tony Mellor†

†Division of Geography, Northumbria University
*School of Historical Studies, University of Newcastle-upon-Tyne

2009
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Why podcast?</td>
<td>3</td>
</tr>
<tr>
<td>Types of podcasts</td>
<td>3</td>
</tr>
<tr>
<td>What is needed?</td>
<td>4</td>
</tr>
<tr>
<td>Creating your own podcast: a step by step guide for students</td>
<td>5</td>
</tr>
<tr>
<td>Creative commons</td>
<td>7</td>
</tr>
<tr>
<td>Where to find &quot;podsafe&quot; music</td>
<td>8</td>
</tr>
<tr>
<td>Three podcasting exercises</td>
<td>10</td>
</tr>
<tr>
<td>Assessment</td>
<td>14</td>
</tr>
<tr>
<td>Working with <em>Audacity</em> software</td>
<td>17</td>
</tr>
<tr>
<td>Installing <em>Audacity</em></td>
<td>17</td>
</tr>
<tr>
<td>Preparing your recording</td>
<td>18</td>
</tr>
<tr>
<td><em>Audacity</em> controls - An overview</td>
<td>20</td>
</tr>
<tr>
<td>Editing a recording</td>
<td>20</td>
</tr>
<tr>
<td>How to publish a podcast</td>
<td>22</td>
</tr>
<tr>
<td>Creating an RSS file</td>
<td>24</td>
</tr>
<tr>
<td>Useful references</td>
<td>26</td>
</tr>
<tr>
<td>Bibliography</td>
<td>27</td>
</tr>
</tbody>
</table>
Why podcast?

A podcast is an internet-based radio show or any audio-based object such as narrative, lecture, individual or group presentation that is made available through the World Wide Web (Morales and Moses 2006). The name "podcasting" derives from a combination of Apple's iPod and broadcasting. The immediate benefit of podcasting technology is the ease with which it can make content immediately available to large audiences. Podcasts are cheap to produce and can be disseminated at no cost on e-learning platforms such as Blackboard or through the World Wide Web. The software is open-source, meaning that it can be downloaded and used for educational purposes without incurring copyright costs. In teaching, podcasts have been used for audio and video recording of lectures in order to make them available to students electronically (Read 2005, Thomas 2006), or instructional purposes, as in, for example, student guides to library use (Jowitt 2008), but the technology potentially has a wider range of applications in science, social science and humanities courses that have yet to be explored. One such use is the student-produced podcast, which has been shown to engage and motivate students who traditionally are shy of video technologies, and build confidence in speaking and communicating research concisely to their peers and tutors (Kemp et al. in review). For students familiar with blogging and iPod technology, podcasting connects with their daily lives and interests and develops creativity in ways different to more traditional forms of assessment. This guide aims to demonstrate the availability and use of podcasting technology to university teachers and provides basic instruction in the set up and operation of user-friendly tools such as Audacity software that have recently emerged upon the market. For students producing their own podcast, this guide will assist in the writing, production and editing of the podcast, and publication of the files on the internet via RSS 2.0. Three podcasting exercises are included that were undertaken by undergraduate students working in groups in courses at Newcastle and Northumbria University. Hopefully these will stimulate lecturers who wish to incorporate interesting podcasting assessments into their own courses.

Types of podcasts

Most podcasts found online are educational or journalistic; their purpose is to instruct or inform students or interested members of the public. This type of podcast typically is delivered in monologue form or, less commonly, in interview format similar to a radio interview. In undergraduate courses, podcasting interviews can be engaging for students to create and may involve an element of group work that reduces self-consciousness and results in a more
relaxed delivery. Monologues are arguably less interesting than interviews although they may appear more structured and have the advantage of communicating information and ideas more efficiently when time or file size is limited. Structurally, podcasts are not very different from the scientific article or undergraduate reports already familiar to students, but like radio interviews, they are presented in ordinary, more conversational language that gives the appearance of freshness and spontaneity. Although they may contain spontaneous elements, they are usually carefully scripted and represent much prior research, practise and editing. Questions are written in advance, often by the interviewee, and answers are often rehearsed. This technique results in efficient coverage of the topic and a clearer structure that should convey information easily to the listener.

**What is needed?**

Even in large courses, the initial outlay for installing a podcasting facility is small. It is necessary to obtain an external digital microphone for voice recordings. A good quality microphone is essential because it reduces the time needed for volume adjustment and minimises unwanted noise from students’ recordings. We tested two brands available from a common electronics shop: a cheap generic microphone (approx. £5) and a Samson Q1U USB microphone (approx. £40). The recording quality of the generic microphone was poor, producing low voice volume on playback and high background noise. In contrast, the Samson produced excellent playback quality in both volume and background noise, and required no installation beyond plugging in on both PC and Apple Mac computers.

At least one PC or Apple computer is required. Students need a quiet room for recording purposes, often more difficult to obtain than multiple, dedicated computers! Having more than one computer/room reduces pressure on students' availability and time. It is also necessary to obtain software for digitally recording and editing sound. In this guide, we describe **Audacity** 1.2.6 for Windows and PC (Audacity Developer Team 2008), which has the advantage of being freeware, distributed under a GNU General Public Licence (Creative Commons 2002). The programme was easily downloaded from the World Wide Web, and proved to be small enough for students to use on their home computers. It is also sufficiently straightforward that students quickly become familiar with its controls and editing tools. A selection of digital music tracks can be made available for short musical interludes.
Additional course time is needed for instruction and supervision. This works best in short (c. 20 minute) sessions to instruct small groups in the use of the software and microphone, with follow up supervision through some of the recording and editing stages. After the initial recording stages, editing of the audio files can be completed by students on their home computers.

Distribution of the finished podcast (if desired) can be achieved cheaply on e-learning platforms or via a Really Simple Syndication (RSS) channel from a website. RSS is an easy way to widely distribute content that is regularly updated, such as news stories, podcasts, video lectures and blog entries. Software programs, called RSS readers, or podcast "clients", such as iTunes or Juice, notify the user when new content is available and present it in an accessible format. Podcast clients also allow users to automatically download new content to a computer or to a portable MP3 audio player, such as an iPod by subscribing to the RSS feed of their favourite podcasters. Instructions for setting up a RSS are given on page 24 of this guide. Websites hosting thematic podcasts are now common in journalism, publishing, education, and marketing. Student podcasts may also be hosted using space on a university server or a commercial hosting service.

Creating your own podcast: a step by step guide for students

The aim of the podcasting exercise is to develop new technological skills in digital broadcasting in order to communicate your work to student peers and other interested parties. The learning outcomes are:

- to be able to coherently express yourself vocally
- to be able to communicate your work to a wide audience
- to be able to develop meaningful and substantial interpretations from complex and diverse information sources
- to become competent in modern, web-based technologies

Steps in the creation process include:

- Working with fellow students to brainstorm appropriate subject matter ideas for the podcast.
- Drafting a storyboard.
- Recording/Editing the podcast using Audacity software on a PC/Mac.
- Writing a final storyboard of the edited podcast accompanied by figures.
• Submitting the written part of your assessment, including storyboard, maps and plots on paper, and including the recorded podcast on a CD in a clearly labelled envelope.

Stage One - Pre-production:

1. Brainstorm about possible content ideas for the podcast. Discuss details such as: What is the purpose of the podcast? Who is the intended audience? What is a logical structure for the script? Who will work on each portion of the script? This may include listening to, and discussing, existing podcasts that are thematically related to your study field.
2. Identify the key messages or points you wish to convey to your audience. How will they be communicated?
3. Draft the podcast storyboard and script. A storyboard is a method of depicting graphically the scene sequence in a presentation or production. Sketch rough cartoons to accompany the podcast script. When producing your full draft, note that a 10 minute podcast will be around 1000 words in length and typically will include six questions.
4. Decide upon a structure. Scripting and delivering an interview is an art not a science, with room to develop your own style. Having said that, there is usually a well-devised format to good interviews.

Title
Provide a captivating title! You should think of this as a headline and eye catcher for your podcast episode. By reading it, a site visitor should want to know more. This means that you should put more in the title than just "Episode #1". Be creative! This should be printed clearly at the top of your submitted storyboard.

Introduction
The most important object of the introduction is to engage the listener. Why should we listen to or read this work? What is the point of it? Who is it useful to?

Background
Often focused on the development of the research.

Methods
What was done? Usually brief.

Discussion
Usually intended to balance opposing views through the use of critical (but not hostile) questioning. The order of these questions may be altered without much detriment to the interview, and this sometimes enhances the appearance of spontaneity. Typical questions
include: What is the meaningfulness/accuracy of the results/data? What are the effects of observed features/phenomenon? What are the implications for other aspects of the landscape/environment/society? What is the significance of your findings?

Conclusion
Never a summary, often tangential to the topic. Occasionally “where do you go from here?” or an opportunity for the interviewer to comment more generally on the topic.

Show Notes
A written summary or outline of the podcast designed to lure listeners. Presented alongside the title on the e-learning site or website where podcasts are available.

Stage Two - Production:

5. Decide upon any special effects. Are you going to use music and jingles? Do you need special sound effects and does it enhance the listener’s experience? After you have written the script for your podcast you need to translate this into an interesting and lively programme. The easiest thing to do is to follow the structure of the script, but just reading the text may produce a static and possibly dull lecture. Instead you want to make it more lively, inspiring and accessible. How do you do this?

Music is a great way to liven things up. It adds variety and drives the programme forward. You can also use music in transition between segments. This serves as a cue that the podcast is moving into something new or changing gears, and gives the audience the time to digest, briefly, what has been said before. Having an introductory theme song is also useful for a couple reasons:
• When your listener hears your theme song, it instantly informs them that they are listening to your show.
• An introductory song raises the energy level and gives some momentum to the beginning of the podcast.

6. Select music and sounds.

IMPORTANT NOTICE:
Before you start using music there are some legal issues you should consider. If you plan to use music in your podcast that is not your own, you need to get permission. It is not legal to use copyrighted material in your podcast without permission! In general, if a piece of music is not written by you or if you don’t
have permission from the creators/owners of the music, then don't use it.

How can you tell if something is copyrighted? It is sometimes unclear when a work is protected. **When in doubt, don't use it.**

What can you use in your podcast apart from pieces of music you composed yourself?

The safest thing to do is to use Creative Commons licensed music. With Creative Commons, the creator has given permission to use the work with certain conditions. The conditions could include any or all of the following:

- You have to give the creator credit.
- You may or may not change the work depending on the license.
- You may or may not use it for commercial use depending on the license.
- You may distribute the work.

You may be interested in using the Creative Commons licenses to protect your own podcast. You can find important information at Creative Commons (http://creativecommons.org/). Music that is licensed in this way is known as "podsafe music" in the podcasting world. Note that you still must give credit to the creator of the music and the source. Details are normally provided in the storyboard or written transcript.

**Where to Find Podsafe Music**

Here are some sources of podsafe music:

- The music and sounds that come with Apple’s *Garageband*, provided free with Apple computers.
- Podsafe Music Network: http://music.podshow.com/
- Special sound effects: The Freesound Project: http://freesound.iua.upf.edu/index.php

If you are unsure about copyright, contact the creator of the music. Explain that you are using the music for educational rather than commercial purposes and ask if you may use his or her music in your podcast. Often, they will permit use of their
music in your podcast because educational uses are regarded as fair uses by many artists.

7. Design the introduction. Many podcasts have a carefully chosen musical theme that opens the programme followed by, or coinciding with, a word of welcome that mentions the name of the podcast and its presenter(s). This is followed by a verbal introduction to the present episode that explains what the listener can expect to hear.

An example of an opening of a podcast:

"Hello and welcome to the North East Geography and Environment podcast! The only programme in cyberspace that deals with the past relations between landscape history and environmental science. I am your host John Smith...

In this episode we will talk about...."

After the introduction and each section a jingle of a (short) piece of music forms a natural break between different parts of the podcast. Again, make sure that the music fits the mood of the topic.

8. Hold recording sessions to produce the podcast.

When you are recording the written script you will discover that sometimes written language is not suitable for speaking. For this reason make first a test recording and note places where the text flows less easily. Adjust the text into spoken language where needed and record again. Sometimes numerous tweaks and adjustments are needed before a section or sentence sounds right.

If you listen to a few examples of informative or academic related podcasts you will get a feeling for how quotes, music, special effects and cliffhangers are used. Good examples of this kind of podcast are:

- **The Missing Link**, a monthly podcast about the history of science, medicine and technology. Available at missinglinkpodcast.wordpress.com/.
- The **Scientific American** podcast. Daily reports and science commentaries related to the journal. Available at www.sciam.com/podcast/.
- The **Talking History** podcast. Available at www.talkinghistory.org/radio.html.
• Exploring Environmental History podcast. Available at www.eh-resources.org.
• The Guardian (UK): audio & podcasts. Available at www.guardian.co.uk/podcasts.

Remember that there is no one correct format for a podcast. Be careful, too, not to overdo the special effects, jokes or anything that might distract from the real information of the programme.

9. Edit and mix audio content as desired. Ensure final version is close to 10 minutes in length.

Stage Three - Post Production

10. Produce a brief summary or outline of the podcast (show notes) to inform potential listeners of its content.
11. Produce a written transcript of the podcast. Include the title, and acknowledge any music or other sources used in its production.
12. Download podcast in iTunes or other podcast directory software.
13. Submit audio file, transcript and show notes for assessment and publication on the course e-learning site.

Three podcasting exercises

Exercise 1
Environmental History, 2nd year, 5 students, School of Historical Studies, University of Newcastle-upon-Tyne.

The podcast assignment was undertaken by students enrolled in a degree programme in history. The course in environmental history (historical geography) uses a mixture of scientific and historical sources to trace the interaction between people and their environment over the last two millennia. History students are accustomed to tutorial and seminar teaching but teamwork is a rare activity, and many students are uncomfortable with the use of scientific sources in their studies. The introduction of a group podcast exercise was intended to encourage teamwork amongst students as well as the discussion of issues and sources in historical
Students were asked to produce a podcast on the basis of an individually researched and written short essay of 1000 words. Essay topics were selected from the following options:

- Did the Little Ice Age put an end to the flowering of European culture during the Middle Ages?
- Was the C20th century exceptional with regard to human impact on the environment? Discuss in relation to the last two millennia.

In groups of 2-3 students, students remodelled essays into a storyboard for a 10 minute podcast. The conventional language of the traditional essay was translated into plain language for a radio show aimed at a general audience, and students were encouraged to expound their arguments in the context of modern environmental concerns. The podcasts were subsequently made available to all students on a password-protected website and were used as the basis for follow-up seminar discussions. In preparation for the seminars students listened to the podcasts and formulated two pertinent questions. They were also asked to provide a brief critical analysis of the content and technical quality of each podcast. The assessment consisted of the traditional essay (60%) and the podcast file submitted on CD with a hard copy of the written transcript (40%).

Insight into the student experience of the podcasting exercise was obtained through specially prepared questionnaires and informal discussions during the final seminar. In particular, these revealed that the production of the podcast focussed the minds of students on the difficulty of writing conversational English. During the recording sessions students were obliged to revise and simplify the text without compromising the content as they recorded. The need to communicate in plain language encouraged students to use language more creatively, and to revisit and question the subject matter of their script. The production process also provided students with opportunities for group discussion and interaction, and to adapt their understanding of the topic and reflect upon their views with others. As a result, students felt that the exercise improved their communication and group working skills. Teamwork clearly enhanced their learning through informal discussions, and in this context one student commented that "...it stimulated the group to really communicate". The students also felt that everyone contributed equally because team members contributed a sub-topic to the essay and were obliged to present it on the podcast.

Most students felt that the work required to produce a podcast was more laborious than writing a conventional essay because it was a
three-stage process, involving a written script, revision for the podcast, and recording. When asked at the end of the course how the podcasting exercise had affected their learning, the students indicated that they felt more engaged with the material, and thought that the exercise provided a more intense and memorable learning experience. One student commented that they were “absorbing it again and again and therefore learned more about it”. They also felt that the essay was a more worthwhile and stimulating exercise (beyond obtaining a grade) because they needed to re-use it for the podcast. Most felt they had produced a better essay as a result.

We concluded that student-produced podcasts enhanced the academic engagement of students through the shared experience of learning and by generating a more meaningful (to the students) piece of assessed work. The informality of the recordings permitted greater student creativity than traditional essay formats and reduced student shyness in presenting work.

Exercise 2
*Drainage Basin Geomorphology, 44 students, 2nd year, Division of Geography, Northumbria University*

Students in science-based modules tend to focus on learning new measurement methods, understanding accuracy and precision, and interpreting data within their sub-disciplines. It was hoped that introducing a podcasting exercise would improve understanding of the scientific and social context of geomorphological studies and would encourage students to make arguments, drawing connections between different kinds of data. In this course, students were asked to produce a 10 minute podcast related to a field data project on a headwater catchment of the northern Pennines. While learning basic techniques in fluvial geomorphology, students assessed channel stability and long-term change on a floodplain that was affected by C19th heavy metal mining. In the field, students measured channel sections, planform morphology and hydraulic parameters that were later mapped and plotted in practical sessions. They were asked to present their findings in the manner of a radio broadcast in which the important results were explained in simple language and their broader significance explored within the context of important social and environmental issues. Podcasts were produced in groups and uploaded onto the respective module e-learning platform (Blackboard) site for other students to access. Assessment was based on the group-produced podcast (mp3 file), a transcript of the final edited recording, and supporting figures and maps from the fieldwork.
Results from the student questionnaire combined with our assessment of the group podcasts strongly suggested that most students enjoyed and were motivated by the technology and novel assessment method. Some students found the most interesting aspect of the exercise "listening to our own voices", "presenting...data in a different way", or "coming up with a format and jokes to make it interesting". Others were satisfied by "the output", or "the fact that we got to communicate our results". The format encouraged creativity, and computer, language and oral communication skills were felt to have substantially improved by more than three quarters of students, although many remained wary of "presentations". A strong perception of improved group working skills by 96% of respondents was an unexpected result, and probably reflected the number of roles available to accommodate students' different abilities and learning styles. These included planning and organising roles, storyboard production, script writing, presenting and technical roles. The most difficult aspect of the exercise was felt to be the planning, writing and editing of the podcasting script, suggesting a deeper consideration of course content. The emphasis on non-technical language and need to be selective in the data discussed increased rather than decreased the difficulty of the exercise and transformed a site-based study of geomorphic processes into a challenging exercise in science communication.

Exercise 3
*Urban Societies, 22 students, 3rd year, Division of Geography, Northumbria University*

Many local and regional authorities, planning consultancies and public agencies and professional bodies now use podcasts to communicate plans and concepts to engage the public and educational audiences. In this module, a voluntary podcasting assessment was offered, although students were offered incentives to participate. It aimed to provide more advanced students with an opportunity to familiarise themselves with a new communication mode in order to enhance their employability and stimulate their curiosity in the subject. Students were asked to devise a podcast exploring a pertinent module theme related to urban geography and applied planning. Podcasts were developed after a series of seminar discussions based on a methodology called “future planning”. Based on group work, "future planning" is a phased technique similar to fore-casting or prospecting, and used in participative social analysis and planning. For assessment, students devised a customised investigation strategy for an applied research essay as one of two modes of summative assessment. The students based their podcast project either on individual research
essays to explore synergies and cross-overs, or on group work in the ‘future planning’ module workshop sessions (formatively assessed). The podcast project was also linked to an optional exam question in a seen exam paper.

The course evaluation showed that the exercise of transforming findings with overlapping themes and investigations into a podcast, collaboratively and in a negotiated mode between the students and with the tutor (two groups of 2, and one group of 5 students), facilitated students’ ownership, reflectivity and team-building skills. It also aided peer learning from the applied research essays, workshops and their dissertations. Furthermore, the exercise increased students' awareness of the changing nature of the planning profession in that consultation with affected communities, or sometimes collaboration, is now a required part of the planning process.

**Assessment**

As a form of oral presentation, assessment of a podcast can follow along similar lines to other student talks, but podcasts have several advantages over student presentations. Firstly they allow the examiner the very useful possibility of a second or a third hearing, the ability to stop and start podcasts as required, and to break between them for assessment and moderation. No time lag need occur between the student performance and its assessment, something that normally cannot be avoided in the examination of multiple student presentations. In the examples described above, the examiners listened simultaneously to the podcasts and provided an independent grading. This was adjusted upon a second hearing and the final grades discussed and agreed within the group. The total amount of time spent in examining podcasts was similar to a written report, and the marking provided a more intimate and engaging experience for lecturers than is sometimes the case for more conventional forms of assessment.

In all discipline areas, the main benefit of using podcasting to students is that it increases the plurality of assessment by introducing a range of assessment types that are more likely to overlap with different students' learning styles and abilities. It is likely to be effective to a range of intelligences and learning styles because it appeals to auditory as well as visual learners and to those who prefer a "hands on" approach. It also suits a range of learning paces because the podcast can be replayed as often as needed, and may be considered a formative exercise in the sense that students review and improve their own performance. The ability to edit the podcast is also beneficial to international or indeed
British students who wish to improve their spoken English. It develops additional transferable skills, particularly Web-based skills, woven in with more traditional inter-personal verbal and communication skills that may make students more attractive to employers. On-line media is becoming increasingly important in academic discourse and communication (Mills 2006, Beldarrain 2006), and students nowadays are expected to be fluent in many types of digital and web-based technologies. Those students who may be nervous of the performance are removed by one stage from the examination situation, although the lack of an immediate audience of either their student peers or lecturers can also be detrimental to the final result. For this reason it is recommended that finished podcasts be made available to other students, either for access and comment in their own time, or utilised during course time as a basis for discussion in seminars or lectures.

The guide to podcast assessment below is adapted from Bell (2007) and was used to mark group assessments in two of the exercises described above. Many of the criteria relate to technical aspects of podcast production but the weighting of content versus delivery can be adapted to different courses. We used a weighting of 70% content, 30% delivery that was consistent with other types of student presentations at these institutions. Assessment can be based specifically on the podcast audio file, saved in a common format such as mp3, together with any supporting essays, reports, figures or data. It is normally helpful to include a written transcript of the podcast to avoid any (inevitable) file access problems.
<table>
<thead>
<tr>
<th>CATEGORY</th>
<th>Excellent</th>
<th>Competent</th>
<th>Fair</th>
<th>Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Introduction</strong></td>
<td>Provides relevant information and establishes a clear purpose, engaging the listener. Tells who is speaking, and where the speaker is located, topic of podcast, what the listener can expect.</td>
<td>Describes the topic and engages the audience as the introduction proceeds. Tells most of the following: who is speaking, topic and structure of podcast.</td>
<td>Somewhat engaging but provides a vague purpose. No information on who is speaking, vague on topic and structure.</td>
<td>Introduction absent or is vague and unclear. Speaker is not identified. No clear focus.</td>
</tr>
<tr>
<td><strong>Content</strong></td>
<td>Creativity and original content enhance the purpose of the podcast in an innovative way. Accurate information and succinct concepts are presented. Remains focussed on the topic. Keeps to specified 10 minutes.</td>
<td>Accurate information is provided succinctly and concepts reasonably well understood. Mostly remains focussed on the topic. Keeps to specified 10 minutes.</td>
<td>Some information is inaccurate or long-winded. Understanding of concepts is hazy. Occasionally strays from topic. Podcast length is more than two minutes too long or short.</td>
<td>Information is inaccurate. Poor understanding of concepts. Unfocussed. Podcast is more than 4 minutes too long or short.</td>
</tr>
<tr>
<td><strong>Delivery</strong></td>
<td>Well rehearsed, smooth delivery in a conversational style. Presenter's speech is clear and intelligible. Expression, and rhythm keep the audience engaged.</td>
<td>Rehearsed, smooth delivery. Enunciation, expression, pace are effective throughout the podcast.</td>
<td>Appears unrehearsed with uneven delivery. Enunciation, expression, rhythm are sometimes distracting during the podcast.</td>
<td>Delivery is hesitant, and choppy or sounds like the presenter is reading. Enunciation is distant or muddled and unclear.</td>
</tr>
<tr>
<td><strong>Music</strong></td>
<td>Music enhances the mood, quality, and understanding of the presentation.</td>
<td>Music provides supportive background to the podcast.</td>
<td>In places, music is distracting background to the podcast.</td>
<td>Music is distracting to presentation.</td>
</tr>
<tr>
<td><strong>Technical production</strong></td>
<td>Presentation is recorded in a quiet environment without background noise and distractions. Transitions are smooth and spaced correctly without noisy or &quot;dead air&quot;. Volume of voice, music, and effects are excellent.</td>
<td>Presentation is recorded in a quiet environment with minimal background noise and distractions. Transitions are smooth with a minimal amount of ambient noise. Volume is acceptable.</td>
<td>Presentation is recorded in a semi-quiet environment with some background noise and distractions. Transitions are uneven with inconsistent spacing; ambient noise is present. Volume is occasionally inconsistent, and either too low or too high.</td>
<td>Presentation is recorded in a noisy environment with constant background noise and distractions. Transitions are abrupt and background noise needs to be filtered. Volume changes are highly distracting Sound level too low or too high.</td>
</tr>
<tr>
<td><strong>Show notes</strong></td>
<td>Show notes provide a captivating title and clear outline of the content. Music credits are included.</td>
<td>Show notes provide a good title. Some music credits.</td>
<td>Show notes provide a poor title with no music credits. May not accurately reflect the content of the podcast.</td>
<td>Show notes provide a poor title with no music credits. May not accurately reflect the content of the podcast.</td>
</tr>
</tbody>
</table>
Working with Audacity software

Audacity is an open-source, freely downloadable, multi-track recording programme and editor for audio files. After a short introduction to its main features, the editing environment allows users to integrate several separate audio clips into a professional-sounding audio file. What follows is a step-by-step guide of how to create a podcast with Audacity.

Installing Audacity


B. Download Audacity for Windows version 1.2.6 (As of May 2009 a Beta 1.3 version is available).

C. Now you need to download and install the LAME MP3 encoder - This allows you export Audacity file format to MP3 files, which can be read by most digital playing software. Click the LAME link on the Audacity download page to download the file. Open the file and follow the instructions.
Preparing your recording

Before you start recording you need to set the preferences.

Open Audacity.

1. Click on Edit ➔ Preferences

This opens the Audacity preference screen with a series of tabs at the top. First select Audio I/O to set the playback and recording preferences.

2. Select the audio device (the sound card of your computer) if this not detected automatically. Then decide if you want your recording to be mono or stereo. If you are recording voice only for a podcast it is recommended that you select mono to keep the file size to a minimum.

3. Using the "Quality" tab, set the sample rate and format of your recording. This is important because it defines the quality of your recording. Set the sample rate at 44,100 Hz, which is CD quality and the sample rate at 16-bit. Leave the other settings on their default values.
4. To enable *Audacity* sound files to be converted and saved as MP3 (.mp3) and wav (.wav) files users must first install the Lame Converter. The Lame Converter can be downloaded from *Lame MP3 Encoder Binaries* ([http://lame.buanzo.com.ar/](http://lame.buanzo.com.ar/)). After downloading the file, unzip it and you will have a file called lame_enc.dll. To use it with *Audacity*, you can put it in any folder, but the first time you want to export an MP3 file, *Audacity* will ask you for the location of this file, so you will need to remember where you saved it.

5. After installing the Lame Converter, click in the *Audacity Preferences* on the File Format tab. Select Read directly from the original file. The export format should be 16-bit WAV.

Click *Find Library* in the MP3 Export Setup section. The next screen asks you to locate the lame_enc.dll file. Click "Yes" and select the folder in which you saved the Lame Converter.

Figure 5 MP3 files are created with the help of the Lame Converter.

6. In *Audacity Preferences* select the tab *Directories* and select the location where you would like to save your audio files.

7. Connect a microphone to your computer. Make sure the settings in the Windows Preferences are correct.

Now you are ready to make your first recording.
Audacity controls - an overview

To start a recording click the Record button and to terminate the recording click Stop.

Now you have made your first recording you can listen to it by jumping to the beginning of the track and clicking on Play.

Editing a recording

Delete a section

If there are unwanted errs or umms and you may like to remove them. Identify the section you would like to delete. You can use the magnify tool to zoom in on the track to help you select the unwanted section.

Highlight the section with the Selection tool. 
Press the delete button on your keyboard to delete the section.

**Adjust volume level**

If a section of the recording is not loud enough you can adjust the volume level:

- Select the section that is too quiet.
- Go to *Effect* in the menu bar at the top and click on *Amplify*.
- Adjust amplification (Db) accordingly with the slider.

**Adding new tracks**

If you would like to add a new track, say you would like to add a second voice, just click the *Record* button.

Add a musical introduction as follows:

Click on *Project → Import* audio and select the music track you would like to add to your podcast.

You can also drag and drop the file directly into *Audacity*.

**Place the track in the required position**

If voice is not needed during the introductory music it needs to be moved to the required position. To do this, use the *timeshift* tool.

Select the *timeshift* tool and drag the voice track forward to the desired position. Release the mouse button.
**How to "duck" music?**
If you desire to have music playing softly in the background of spoken words but the music is too loud you need to adjust the music level. This technique is called "ducking". To duck music:

Select the music section to be used as background → click **Effect** → **Amplify**.

**Add "fade in" and "fade out"**
if music needs to fade in or out do the following:

Select the section that needs to fade in our out → Click **Effect** → **Fade In or Fade Out**.

**Solo and Unsoloe track**

Sometimes it is necessary to hear only one track in order to edit it. For this purpose a track can be "soloed" or "unsoloed". To do this click on the *Solo* button to the left of the track that needs to be solo.
How to publish a podcast

Publishing a recording as a podcast is simple. The first step is to create an MP3 file, as follows:

Click on File → Save Project → and type file name in the frame that appears. Save the file.

A new screen (ID3 tags) will ask you to provide information about the podcast "metadata". This information will tell media players the name of the podcast, the author and other details. It is good practice to label your podcast so that people know where it came from and who made it.

Adjust the metadata (info) further in iTunes in order to add more complete information about your podcast.

**iTunes**

Open the MP3 file in iTunes. Right-click on the file name and click on Get Info.

A summary screen providing technical information about the file appears on the screen. Click on the tab Info.
On the adjacent *Info* screen you can adjust information about the podcast such as the title, producer/presenter, name of podcast and year of publication.

Name = title of podcast  
Artist = name producer or presenter  
Album = name or title of podcast series  
Genre = This is normally *Podcast*

It is not necessary to add further information in the comments box since the show notes, i.e. description of the podcast, will be provided in the RSS file.

When done, click on *OK*. Now the MP3 file is ready to be uploaded to the server and made public.

**Creating an RSS file**

If you are creating an RSS file that includes podcasts, you should use the RSS 2.0 format. Additional optional elements for podcast RSS files are described at the Apple Web site (see link below).

Once you have placed the audio (MP3) file on the server, you can create the RSS file to which people can subscribe and place it on the same Web server as the audio file.

N.B. While there is no need to learn HTML or XML (Extensible Markup Language), it is useful to understand the structure of an RSS file in order to be able to edit it properly.

The example below shows an RSS file that supports podcasts. You should change the bold portions of the file to be specific for your site. Don't change the rest of the code!

```xml
<?xml version="1.0"?>
<rss xmlns:iTunes="http://www.iTunes.com/DTDs/Podcast-1.0.dtd" version="2.0">
  <channel>
    <title>Your podcast series title</title>
    <link>http://www.url.ac.uk/learn/rss/podcasts/</link>
  </channel>
</rss>
```
<description>This is a test podcast series</description>

<item>
<title>This is a title of an episode</title>
<description>A short description of a particular issue of the show</description>
<enclosure url="http://www.locationOfAudioFile.com/learn/rss/podcasts/test.mp3" type="audio/mpeg" />
<pubDate>Fri, 7 Dec 2006 11:20:00 GMT</pubDate>
<iTunes:author>John Smith</iTunes:author>
<iTunes:duration>18:28</iTunes:duration>
</item>

<item>
<title>Sample Podcast 2</title>
<description>A short talk on picking bananas</description>
<guid>http://www.locationOfAudioFile.com/learn/rss/podcasts/test2.mp3</guid>
<enclosure url="http://www.locationOfAudioFile.com/learn/rss/podcasts/test2.mp3" type="audio/mp3" />
<pubDate>Fri, 7 Dec 2006 11:20:00 GMT</pubDate>
<iTunes:author>John Smith</iTunes:author>
<iTunes:duration>18:28</iTunes:duration>
</item>

</channel>
</rss>

To add new episodes just copy the information between the <item> tags and past it below the last item but before the </channel> and </rss> tags.

Alternatively you can use the The Amazing Podcast XML Source Code Creator, an online XML file creation tool. Go to http://podcast.redevelopments.co.uk/podcasting/podcasting.asp?podcasts and follow the instructions.

Posting Your RSS File

When you are finished creating your RSS file, save it with ".rss" as
the extension. For example, name the file finearts.rss.

If you would like people to find the RSS feed place the following code line between the HEAD tags of your web page (replace the bold with the location of your RSS file):

```
<link rel="alternate" type="application/rss+xml" title="RSS" href="url/to/rss/file"/>
```

For more information about making and publishing RSS feeds visit the apple website iTunes store (http://www.apple.com/iTunes/store/podcaststechspecs.html#metadata).

**Useful references**


The criteria for assessing student group-produced podcast table is based on this article.

Department of History and Art History. 2009. *Centre for History and New Media*, George Mason University, Fairfax, Virginia. Available at: http://chnm.gmu.edu/

The website of the Center for History and New Media provides useful information on the use of web 2.0 technologies in the classroom. The Center also maintains a podcast and might provide students with ideas about how to structure a podcast.


This page provides a brief introduction to podcasting and a step-by-step guide to the process of producing a podcast. Very useful reference!


The online encyclopedia includes an article that explain RSS in depth as well as its development, history and uses.
Bibliography


